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1 Intr oduction

The original version of the Graphical User Interface(GUI) to the Concurrent PCODEInterpreterof the
BACI Systemwascreatedin 1996 by Vince Gibsonin partial ful�ll mentof the requirementsfor a Masters
Degree in Computer Scienceat theUniversityof Alabamaunder the directionof Tracy Camp. His design
wasmodi�ed and improvedsigni�ca ntly in thesummer of 1998 and 1999.

TheBACI GUI programgivestheuserthecapabil ity to monitor all aspectsof theexecution of aprogram
written in either C�� or Pascal, the languagessupportedby the two compilers of the BACI system.All
source �les used to produce the programaredisplayed, if they areavailable. The user cansetbreakpoints
andsingle-stepateitherthesourcecodelevel or thePCODE level. Theusercanview theprogramdataand
thePCODEinstructionsexecuted. All non-sourcewindowscanbesavedto disk.

TheBACI GUI programrequiresaUNIX operating system(Linux, Sun4, IRIX, or AIX), equippedwith
theX11 windowing system andtheTcl8.0andTk8.0 programlibrariescreatedby John Ousterhout.

Programsof the BACI System

program function describedin
bacc BACI C�� to PCODECompiler cmimi.ps
bapas BACI Pascalto PCODECompiler guidepas.ps
bain terp command-linePCODE Interpreter cmimi.ps,guidepas.ps

disasm.ps
bagu i Graphicaluserinterfaceto the thisdocument (guiguide.ps)

PCODEInterpreter(UNIX systemsonly)
badi s PCODEde-compiler disasm.ps
baar PCODEarchiver sepcomp.ps
bald PCODElinker sepcomp.ps

2 The Top Level Menu Bar

The BACI GUI program is composedof two parts: thebinary executable�le anda Tcl/Tk script, both of
whichshould be locatedin thesamedirectory.

Whenyou invoke theBACI GUI from anXterm window, you should seethe top level menu bar shown
in Figure1. Wediscuss theFile, Options,Data,andBreakpoint choicesin Sections2.1-2.4, respectively.

Figure1: Top Level Menu Bar

The buttons acrossthe bottom of the menu bar are associatedwith the execution of a program. At
startup, all of thebuttons across thebottom of the bar excepttheExi t button aredisabled. To enable these
buttons,youmust�rst openaPCODE � le usingtheFi le menu(seeSection 2.1).

After a .pco �le hasbeenopened,theRun buttonwill betheonly inactivebutton. TheContinu e button
will continueto execute the�le thathas been loaded until thenext breakpoint is reached(seeSection4 on
breakpoints), or the last PCODE instruction of theprogramhasbeen executed.The1 pco and 1 sourc e
buttonsexecute one PCODE instructionor onesourceline, respectively. ThePause buttonpausesprogram
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execution. The St op button terminatesprogramexecution. The Run button and theOpen PCODE f ile item
of theFile menu (seeSection2.1 below) areboth re-activated, sothateithertheprogramcanbere-executed
from thebeginning or a new programcanbeloaded.TheExit buttonexits theBACI GUI program.

2.1 TheFileMenu

Figure2 shows the Fil e menu of the top level menubar.

Figure2: File Menu

As you can seein Figure 2, the only active item in the menuis Open a PCODE f ile . The Reloa d
cu rren t PCODE fil e item is activated aftera PCODE � le hasbeenloaded. This item would typically be
usedin the case whenthe programsource is modi�ed and recompiled in a separatexter m window. The
inactive items on the menubelow the separatorbar areactivatedafter their corresponding windows have
beencreated.The PCODE window is createdwhenyou choosethe Debug PCODE item from the Option s
menu (seeFigure 3). Section 5 discussesthe PCODEwindow. The Data window is createdwheneitheryou
chooseto view programdataby selecting itemsfrom eithertheDat a (seeFigure 4) or Opti ons menusor
datais generatedby a runtime exception. Section6 discussesthe Data window. The Pr oces s window is
createdwhena PCODE �le is opened. Output generatedby the processappearsin this window. Section7
discussesthePr oces s window.

2.2 TheOptionsMenu

Figure3 shows the Opt ions menu of the top level menubar.

Figure3: OptionsMenu
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You can usethis menu to selectseveral different executionoptions. You can choose to display the
activation record (AR) of each procedure or function on entry or exit. The Data window will be created
to display the information. You canhave the termination of eachconcurrent processwritten to the Dat a
window also.

Turning on the Debug PCODEchoice button creates thePCODEwindow anddisplayseachsubsequently
executedPCODEinstruction. Turning off the Debug PCODEchoice buttondeletesthePCODEwindow.

By default,eachconcurrentBACI processis providedaseparatewindow into which it writesits output.
If the number of concurrent processesis large, thenthe clutter in the root window from the processwin-
dowscanbeundesirable. Turning off theShow proc ess wind ows removesall processwindowsexceptthe
window for themainprocess.

2.3 TheData Menu

The Data menu is shown in Figure4.

Figure4: DataMenu

AsyoucanseefromFigure4, youcanview thecurrent valuesof theglobal variables,thevariablesglobal
to a monitor, the variables of thecurrentprocesses,or thevariablesof the currently executing function or
procedure. You canalsochoose to view the current stateof theprocess table and the runtime stacks. All of
this informationwill bedisplayedin the Dat a window.

Figure13showsanexampleof typical Datawindow usage.

2.4 TheBreakpointsButton

TheBr eakp oin ts button in the top level menubar (seeFigure1) is not amenubutton. Clicking this button
createsa window with which you cansetand unsetbreakpoints at both thePCODE and source line level.
TheBreakpointswindow is discussedin Section4.

3 Selecting a PCODE File to Execute

To opena PCODE �le to execute,simply select the Open PCODEFi le item of the File menu on the top
level menu bar (seeFigure2).

Openinga PCODE �le will createa �le selectionwindow like the oneshown in Figure5. The name of
thecurrent directory is shown in aneditable �eld at the top of thewindow. By modifying thenameof the
directory shown andpressingRETURN, ausercanmove to any nodein theuser'sdirectory tree.
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Figure5: OpenFile DialogWindow

Notice that all directories are marked with trailing slash (/ ). Double-clicking on a directory name
changesto thatdirectory. Thedirectoryname.. / denotestheparent directory of thecurrentdirectory. This
providestheuser analternativemeansfor traversingtheuser'sdirectory tree.

Only �les having the. pco suf�x (thePCODE�les) anddirectoriesarelistedin the�le selection window.
Whenyou selecta PCODE�le, then sourcewindows arecreatedto displaythe source�les usedto create
thePCODE �le, if thesource�le s areavailable. In addition, theoutput window for themainprogram(the
Main processwindow) is created.

Figure 6 shows what will happen when the f airs em3.pco PCODE �le is selected.This PCODE�le
wascreatedwith threedifferentsource �le s, fai rse m3.p m, fai rsem 3.in c, andcomp-swa p.in c. Each
source�le is displayedin aseparate sourcewindow.

4 Sett ing and Unsetting Breakpoints

Breakpointsaremanipulatedthrough theBreakpointswindow createdwhen theBre akpo ints buttonon the
top of the top level menu bar (seeFigure 1) is clicked. The Breakpoints window for the fai rsem 3.pc o
program is shown in Figure7.

Noticethat abreakpoint hasbeen setatPCODElocation437online 15 of thesource�le fai rsem 3.p m.
This breakpoint was set by one of two ways: by entering the number “437” in the entry box next to
Enter PCODE addre ss f or a br eakp oin t or by entering thenumber“15” in theentry box next to Ente r
so urce lin e number fo r a bre akpo int . Thebreakpoint is markedon thelineof theappropriatesource
window with a b characteron theleft of the line (seeFigure11).

If you try to placea breakpoint on a line of a source�le that doesnot generate any PCODE, thenthe
breakpoint will actually beinsertedjust before the next sourceline that generatesPCODE.In thefollowing
C�� sourcecodefragment, if you try to insert

12 i = 0;
13 do {
14 /*
15 iter ate over the
16 elem ents of the array
17 */
18 a[i ] = i;
19 } whil e (i < max_a );

a breakpoint at line 15, the breakpoint will be set on line 18, becausethe comment spanning lines 14
through 17 doesnot generateany PCODE. Theselines of the program source do not correspond to any
executablePCODEinstruction.
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Figure6: Root Window after Opening a . pco File

Whenmore thanonesource�le is usedto create a PCODE �le, aswasthecasefor the fai rsem 3.pc o
�le, therewill beamenubuttonto theright of theSource Fil e: labelin thesecondpaneof theBreakpoints
window. The nameof the currently selected�l e will be the title of this menubutton. Clicking the menu
button will pop up a list of �les (seeFigure 8). Initially, the primary source �le is selected and its name
appearson themenu button.

In Figure8, thesource �le fair sem3.in c hasjust been selected. When themenuis released,the the
corresponding sourcewindow will rise to the top of thewindow stackandthename of thechosen source
�le will becomethe label on themenubutton.

Whena PCODE�le is producedby a single source �le, the menu button to the right of the Sourc e
Fi le: labelis replacedby thenameof theonly source�le.

To deletea breakpoint, simply select thebreakpoint you want to deletein the listbox below the second
pane of theBreakpoints window and click the Dele te sele cted bre akp oint button along thebottom of
thewindow. If you click theDelet e se lec ted brea kpo int button whenthereis no breakpoint selected,
then the message window shown in Figure 9 will appear. After � ve seconds, the messagewindow will
disappear. TheseBACI Notewindows areused in severalplaceswhenthereis information the userneeds
to have,but nouserresponseis required.

Whena programexecution reachesa breakpoint thathas beenset, a breakpoint alertwill appear. The
breakpoint alertcorresponding to thebreakpoint on line 15 of the fai rse m3.p m�le is shown in Figure 10.
This alert will remainuntil you click one of theotherbuttons on thebottomof thetop level menu bar, such
asContinu e 1 pco , 1 sour ce , Stop , or Exi t .

Whena breakpoint is reached,the sourcewindow that contains the line where the breakpoint hasoc-
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Figure7: BreakpointsWindow

curred will rise to the top of the source window stack and the line corresponding to the breakpoint will
behighlighted. Figure11 shows the sourcewindow for the fa irs em3. pm �le just after thebreakpoint on
line 15 hasoccurred.

5 The PCODE Window

The PCODEwindow is createdwhenyou select the Debug PCODEoption from the Optio ns menu(see
Figure 3) of the top level menubar. Figure 12 shows the PCODE window for the fai rsem 3.p co program
justafterthebreakpoint at location 437 (line 15of f air sem3.pm) hasoccurred.

ThePCODEwindow is especiallyusefulwhen you areusingthe1 pc o buttonof thetop level menubar
to executeonePCODEinstructionata time.

WhenthePCODEwindow exists, its contentscanbewritten to a �le with the Write PCODE Windo w
entryof theFile menu(seeFigure2) in the top level menubar.

6 The Data Window

The Datawindow is created eitherwhenyou selectone of the items from the Data menu(seeFigure4) of
thetop level menubaror when debugging datais generatedby a run time exception.

Figure13showstheDatawindow after adumpof theglobalandmainprocvariablesof thef airs em3.pco
program. Note that theData window is time stampedwhenit is opened.Eachcollection of data written to
theDatawindow is identi�ed with the number of theprocessrunning at thetime of the dump, thePCODE
location, thesource linenumber, andthetimeand date.

7 The Process Windows

The window for the Main processis createdwhenthe PCODE �le is opened. Any output generatedby the
mainprogramappears in this window. Output from all of theprocesswindows generated during program
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Figure8: SourceFile Menuof theBreakpoint Window

Figure9: BACI NoteAlert

execution is shown in theMain processwindow. Figure14 shows themainprocessjustafterthebreakpoint
on line 15of thesource � le fair sem3.pm hasbeenreached.

Thefair sem3.pm programcreateseight concurrentprocesses.Eachof themhasits own output window.
Figure 15 shows thewindow for process2 whenthe breakpoint on line 15 of thesource�le fa irse m3.p m
hasbeen reached.

If a loadedprogramis re-run or if anew PCODE�le is loaded, thenall processwindowsaredeleted and
re-createdwhenneededastheprogramexecutes.

Figure10: Breakpoint Alert
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Figure11: SourceFile Window ataBreakpoint

Figure12: PCODE Window

Figure13: DataWindow
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Figure14: Main ProcessWindow

Figure15: A ProcessWindow


